
 

 

 

TURBOPK  
USER MANUAL 

 

 

 

 

 

 

March 2014 

 

 

 

 

  

 

Patrick Buckley 

SURVICE Engineering LLC 

 



 
 

Page | 2 
 

Contents 

1.0 Installation ......................................................................................................................................................... 3 

2.0 First Example Calculation ........................................................................................................................... 4 

3.0 Rayleigh Burst Point Option ................................................................................................................... 14 

3.1 Rayleigh Distribution In Weapon Coordinates ......................................................................... 19 

4.0 HEI Projectile Grid ....................................................................................................................................... 28 

5.0 Projectile Parallel Shotline Options .................................................................................................... 31 

6.0 Parallel Shotlines - Add Armor Option .............................................................................................. 37 

7.0 Single Burst Point Option ......................................................................................................................... 41 

8.0 Graphics Display Control .......................................................................................................................... 44 

9.0 Edit Menu ......................................................................................................................................................... 45 

9.0 Warhead Files ................................................................................................................................................ 46 

10.0 Shotline Inspector ................................................................................................................................... 49 

11.0 Burst Point Grid Polar Coordinates ................................................................................................ 58 

12.0 Rectangle of Trajectories Option ..................................................................................................... 60 

13.0 Air Blast Model ......................................................................................................................................... 71 

14.0 Miscellaneous ............................................................................................................................................ 79 

  



 
 

Page | 3 
 

1.0 Installation 

TurboPK comes as a single "ZIP" file with a name like "TurboPK_v1.1.4_64bit.zip."  The 
“v1.1.4” in the same indicates the current version number (yours may be different), and 
“64bit” indicates the computer word size. Other names may have “32bit” or “Linux”, for 
which 64-bit is the only version. There are a number of ZIP utilities that can unzip this file. 
If you don't have one, we recommend IZARC (www.izarc.org/download.html) because that 
utility was used to create the ZIP file in the first place.  

Unzip the TurboPK ZIP to the folder of your choice, for example c:\TurboPK_Standalone.  
(Do not unzip it to C:\Windows or any of its sub-folders.) 

Unzipping the file will create the following contents in the folder you selected (Figure 1): 

 

Figure 1 - TurboPK ZIP contents. 

The base folder has the application file (turbopk.exe) and three DLLs (QtCore4, QtGui4, and 
QtOpenGL4). The DLLS are from the Qt software development system, which was used to 
create TurboPK. Unfortunately there are many different versions of the Qt DLLs, not all of 
which are compatible with TurboPK. And the ones that are compatible with TurboPK are 
not necessarily compatible with other Qt-based applications you may have on your 
machine. So we strongly advise that you keep the TurboPK executable and its DLLs in the 
same folder, and that folder not be C:\Windows or any of its sub-folders. If you want to 
move TurboPK to some other folder then make sure the Qt DLLs are also moved to the new 
folder. 

Note that your particular ZIP may contain other files, including other DLLs which should be 
treated in the same way. 

To create a TurboPK icon on your desktop just drag-and-drop the executable file name onto 
your desktop. 
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2.0 First Example Calculation 

Launch TurboPK by double-clicking on the TurboPK.exe file name, or by double-clicking on 
its desktop icon. You should see the following startup window: 

 

From the File menu select the File Open File Set item (Figure 3).  

Figure 2 - TurboPK startup window. 



 
 

Page | 5 
 

  

This pops up a folder selection box (Figure 4). In the case of Figure 4 the folder Vehicle is 
selected. Vehicle is a sub-folder provided in the distribution zip file. This will cause 
TurboPK to load several files from the Vehicle sub-folder. 

Figure 3 - Opening a set of files. 
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The files loaded into TurboPK include "vehicle.msh," which is the target geometric model. 
"Vehicle.pkh" is the set of damage functions for the vulnerable components in the target 
model. "Vehicle.mv" contains the fault tree describing the logical interconnections between 
vulnerable components. "ExampleWhd_ZDATA.zdata" is a ZDATA description of a 
fragmentation warhead. "Example.prjc" is a JTCG-projectile file, and "blast" is an air blast 
vulnerability file. 

Figure 4 - Selecting the Vehicle sub-folder. 
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ZDATA files contain information about fragment masses, but not fragment shapes or 
fragment materials, so the dialog box shown in Figure 6 pops up asking the user to define a 
fragment shape and to pick a fragment material. (See Section 9.0 for more details.)  The 
dialog box titled "Fragment Parameters" presents five shape options and a drop-down list 
for specifying fragment material.  The edit controls that are grayed out become active when 
their associated fragment shape is selected. 

Figure 5 - Files loaded from the "Vehicle" folder. 
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Each time a warhead file is loaded the user is prompted to enter a "TNT Equivalent Weight" 
for air blast calculations (Figure 7). A description of the air blast algorithm is provided 
later. The "TNT Equivalent Weight" parameter in this case is the equivalent weight for 
pressure. 

 

The File Open File Set option is just a shortcut method for opening the files individually. 
The underlying code will go to the folder selected by the user and will load the first file of 
each type (.msh, .pkh, .mv, .pzw, and .prjc) it encounters.  

The analysis options offered by TurboPK are found in the Actions menu. For this example 
the item Actions...Burst Point Field is selected (Figure 8). This pops up the dialog box 
labeled "Burst Point Field" (Figure 9). This option generates a set of burst points at a fixed 
height above the z = 0.0 plane in target coordinates.  

Figure 7 - Explosive weight dialog 

Figure 6 - Fragment shape dialog. 
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Figure 8 - Actions menu       

Figure 9 - Burstpoint field dialog 

Azimuth and Elevation define the approach angles of the weapon with respect to the target 
at rest.  Azimuth of 0.0 is "head-on."  Elevation of 0.0 is parallel to the ground plane. 
Elevation of 90.0 is diving down onto the target. "Speed" refers to the weapon's speed. 
Burst height is the height of the burst point plane above the z = 0.0 plane in target 
coordinates. Burst point spacing is the distance between burst points as measured in the 
burst point plane. Grid Edge Dimension is the edge dimension of the burst point plane 
square. No. Trials per Burst Point is the number of point-burst Monte Carlo trials that are 
conducted at each burst location. "Nose to warhead CG distance" is the distance from the 
nose of the weapon in question to the center of gravity of the warhead. This is a distance so 
it is always positive. The check box "Do all burst points" controls whether or not certain 
burst point locations are generated. In particular, it is possible for a burst point to be 
located at a point beyond where its associated weapon trajectory would have already 
intersected the target geometry. Checking the box will cause these burst points to be 
generated in the grid even though the weapon would have hit the target first. Clicking the 



 
 

Page | 10 
 

Ok button in the dialog box causes TurboPK to generate the grid of burst points and do the 
burst point simulations. Results are computed as average PK values per burst point and are 
presented as color-coded markers at the burst point locations (Figure 10). 

 

A few summary statistics are presented in the bottom frame of the TurboPK main window. 
In this example there were 100 burst points.  PK averaged over the 100 burst points was 
0.71. Run time was 0.35 seconds. The warhead in this example has a total of 2000 
fragments, so each Monte Carlo sample point-burst involves simulating 2000 randomized 
fragment rays.  It also involves a set of 14,400 “blast rays" generated at 3-degree intervals 
in polar angle and roll angle. Performing 20 Monte Carlo samples at each of 100 burst 
points therefore involves simulating a total of 3*107 rays.  

A higher resolution version of the example calculation is shown in Figure 11. In this case 
the spacing between burst points was set to 0.1 meters, which results in 9800 burst points. 
This calculation involves roughly 3*109 fragment rays and required 22.5 seconds of 
calculation time.  

Figure 10 - Burst point field PK values 
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Figure 12 shows the Windows Task Manager during the 9800 burst point run. It shows that 
TurboPK is using 100% of the CPU compute power. Core i7 processors have four full 
computing cores, but each core is "hyperthreaded" so two separate computational threads 
share each core's computing resources. Hyperthreading appears to Windows as eight 
separate computations running simultaneously, so its performance window reports the 
usage of eight "CPUs."  TurboPK was built from the ground up to take advantage of multi-
core processor designs through parallel programming techniques and Figure 12indicates it 
is successful in using all cores at the same time. 

Figure 11 - Burst point spacing reduced to 0.1 meters. 
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This example used the File Open File Set shortcut to load all the necessary files in one 
operation, but the user could have done the same thing by loading the files via their 
individual menu items. For example, .msh files are opened via the menu item File...Open 
Ascii Mesh File (Figure 13).  

Figure 12 - Windows performance monitor. 



 
 

Page | 13 
 

 

The next sections describe the various Action menu items in the order of their appearance 
in the Actions menu. 

Figure 13 - Opening a mesh file. 
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3.0 Rayleigh Burst Point Option 

This option is invoked via the menu item Actions...Rayleigh Burst Points. (NOTE: This 
option changed in 2014 to include the words “Target Coordinates”, with an additional action 
for “Weapon Coordinates”. This section discusses the Target Coordinate version.) Figure 
14shows this menu item being selected and the dialog box that pops up in response to it. 
This option generates a set of burst points in the target z-plane specified by the "Centroid 
Z" coordinate. The distribution center point in the x-y plane is specified by the "Centroid X" 
and "Centroid Y" coordinate values.  "CEP" (Circle of Equal Probability). The equation for 
the cumulative distribution function for a Rayleigh distribution contains one parameter: . 
One CEP is 1.17.   

 

 

Figure 14 - Rayleigh burst point option. 
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"Az" and "El" are the azimuth and elevation angles of approach, respectively. Their 
conventions are as described in the previous section. "Number of Burst Points" and "No. 
Samples per BP" are self explanatory.  "Fuze Delay Distance" applies to trajectories that 
intersect the actual target geometry.  If a trajectory intersects the target geometry then a 
zero fuze delay distance makes the target intersection point the burst point for that 
trajectory. A positive delay distance moves the burst point  "into" the target geometry 
while  a negative delay distance  backs the burst point "away" from the geometry model 
intersection point. Figure 15and Figure 16 show the results of  the Rayleigh Burst Point 
option for the parameters shown in Figure 14.  

 

Figure 15 - Rayleigh Burst Point example, top view. 
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Figure 17 and-Figure 18 illustrate the effect of a negative delay distance. In this example 
the nominal burst point plane is the ground plane (z = 0.0 for this target model).  Weapons 
are approaching from the front at a diving angle of 45 degrees.  Figure 17 is for zero delay 
distance and Figure 18 if for negative 2-m delay distance. 

Figure 16 - Rayleigh Burst Point example, oblique view. 
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Figure 17 - Zero delay distance. 
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As indicated by the check boxes in Figure 17, only fragment effects were considered for the 
calculations shown in Figure 17and Figure 18. 

Figure 18 - Negative 2-m delay distance. 



 
 

Page | 19 
 

3.1 Rayleigh Distribution In Weapon Coordinates 

The previous section allowed the user to define a Rayleigh distribution of burst points 
located in a fixed elevation relative to the target origin. Figure 19 shows an example 
distribution located 3-meters above the target origin. This capability is useful for analyzing 
artillery rounds which "fall" onto their targets. 

 

For flat-fire weapons a Rayleigh distribution is also used to describe the miss distribution, 
but in this case the miss distribution is defined in a plane perpendicular to the projectile's 
direction vector, as opposed to being in the "ground plane" like it is for artillery projectiles.  
So a new option has been added to TurboPK allowing the user to specify a Rayleigh 
distribution for miss distances in weapon coordinates. Figure 20 shows the menu item for 
invoking this option. 

Figure 19 - Example Rayleigh distribution in target coordinates 
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Figure 21 shows the dialog box that pops up in response to the menu item. This dialog box 
also presents a set of inputs for doing multiple weapons in a "salvo" but ignore those for 
the time being. Figure 23 shows the results of applying the parameters shown in Figure 21. 

Figure 20 - Rayleigh Distribution in weapon coordinates option. 
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Figure 21 - Rayleigh Distribution / Weapon Coordinates Dialog 

The Az/El pair (0.0, 0.0) specified in Figure 3 is head-on to the nose of the vehicle so the 
impact positions roughly describe a circle when viewed from the front of the vehicle. 
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Figure 23 - Rayleigh Weapon Coordinates Results 

Now consider the Multiple Weapon Attack option shown in the dialog box. To see its 
effect an example calculation will be done first with the single weapon parameters shown 
in Figure 24. That is, an attack at 70-degrees elevation angle, a CEP of 0.75 meters, and a 
nose-to-warhead distance of 0.5 meters.  The latter means the warhead burst point will be 
0.75 meters prior to the intersection of the projectile's trajectory with the target geometry. 
Figure 25 shows the distribution of burst points from a 70-degree elevation viewpoint, and 
Figure 26 shows the burst points from an oblique view. As indicated at the bottom of Figure 
26 the average PK over 1000 burst locations is 0.50 in this case. (Discussion continued after 
Figure 26.) 
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Figure 24 - Single Weapon Parameters 
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Figure 25 – 70 Degree Elevation 
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Figure 26 – Oblique View 

Next, the Multiple Weapon Attack option is selected and the parameters set to the values 
shown in Figure 27. Each salvo consists of two projectiles. A total of 1000 salvos will be 
generated. For each salvo 20 Monte Carlo sample fragment patterns will be generated for 
each projectile in the salvo. Az, El, CEP, etc are as shown.  
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Figure 27 - Multiple Weapon Attack Parameters 

In the case of the Multiple Weapon Option for each salvo the vulnerable component PK 
values are accumulated over all projectiles in a salvo prior to fault tree evaluation. Figure 
28 shows the post-calculation results in the status bar at the bottom of the main window. In 
this example the average salvo-PK is estimated to be 0.9316. There is no burst point PK 
display because the target PK values are accumulated over all burst locations in each salvo. 
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Note that simply compounding the single round average PK for two rounds would give a 
compounded average PK of 0.75. 

 

Figure 28 - Multiple Weapon Attack Results 
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4.0 HEI Projectile Grid 

This option simulates the fragmentation effects of High Explosive Incendiary projectiles.  It 
is accessed via the Actions...HEI Projectile Grid menu item. Figure 29 shows this menu 
item and the dialog box that pops up in response to it.  Azimuth and Elevation angles obey 
the conventions previously described.  This option creates a grid of projectile trajectories 
that overlays the presented area of the target from the specified azimuth and elevation 
angles.  "Spacing" refers to the spacing between projectile shotlines. "Delay Distance" is a 
fuzing delay distance as described in the previous sections. "No. Samples" is the number of 
Monte Carlo point-burst samples done at each projectile burst location. 

 

By default the fuzing delay distance is set to 0.1524-m (6.0 inches), the "projectile" will be 
placed 6-inches inside the geometry model relative to its first intersection with the 
geometric model. Changing the Elevation angle to 90.0 degrees and clicking on the Ok 
button should produce something like Figure 30. 

Figure 29 - HEI projectile grid option. 
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The PK markers in this case are drawn at the burst points, which in this case are internal to 
the geometric model, hence not visible. To make them visible click on the transparency 
control button (fourth from the left) and set the transparence to 40%. The PK markers are 
now visible (Figure 31). 

Figure 30 - HEI example. 
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Note the white PK markers in Figure 31. These are associated with burst points that are 
located inside a volume-mode (solid) object. It is not clear how to proceed for these burst 
points because the physical state of the projectile is called into question for these cases, and 
the characterization of the fragmentation (mass, speed, direction) are for a projectile in 
free air, not one buried inside a solid object of some kind. Therefore, TurboPK ignores burst 
points that are inside solid objects. 

Figure 31 - HEI example, transparent view. 
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5.0 Projectile Parallel Shotline Options 

One of the standard techniques in vulnerability analysis is to analyze an entire "grid" of 
parallel shotlines. The grid overlays the projection of the target model from whatever 
(azimuth, elevation) pair a user specifies. Figure 32 for example displays a shotline grid 
overlaying the example vehicle model from the angles (135,0). Blue lines have been added 
to delineate grid cells and red dots have been added to indicate shotline locations.  

 

The first parallel shotline option is accessed via the menu item Actions...Projectile 
Parallel Shotlines - Impact Speed (Figure 33). 

Figure 32 - Example shotline grid. 
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Selecting Actions...Projectile Parallel Shotlines - Impact Speed pops up the dialog box 
shown in Figure 34. The parameters Azimuth, Elevation," and "Shotline Spacing" are as 
described previously. Speed refers to the projectile, or fragment, impact speed. The center 
section of the dialog is a set of radio buttons for electing to analyze a projectile, or a cube 
shaped steel fragment, or a spherical steel fragment. If Use Projectile is selected TurboPK 
uses whatever projectile definition was last loaded by the user. If Use Cube Fragment - 
Steel or User Sphere Fragment - Steel is selected then the Frag Mass - Grains window is 
activated. The input control labeled Max RHA Addition. inches is described in a later 
section of this document. 

Figure 33 - Parallel shotline option. 
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Changing the Elevation parameter to 90 degrees and clicking on the Apply button should 
produce an image similar to Figure 35. The colors represent the projectile’s speed at 
intersection with the first vulnerable component encountered along its shotline. Spin 
buttons in the dialog box allow for easy modification of azimuth, elevation, shotline 
spacing, and impact speed. 

Figure 34 - Parallel shotlines dialog box. 
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The second parallel shotline option is accessed via the menu item Actions...Parallel 
Shotlines - Pk. Figure 36 shows its effect for 90 degrees elevation and the projectile threat. 

Figure 35 - Projectile shotline grid example. 
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Note that the color scale is now from 0.0 to 1.0.  This option will not work unless a set of 
vulnerable component PK/H (probability-of-kill-given-a-hit) functions have been loaded for 
the target model.  PK/H functions specify a damage probability for a component as a 
function of the mass and speed of the object striking them. Most commonly, PK/H functions 
are expressed as bi-variate (mass and velocity) piecewise-linear functions. When a user 
invokes the menu item Actions...Parallel Shotlines – PK the code will compute the 
probability of killing one or more vulnerable components found along a shotline.  For a 
given shotline it does that by applying the appropriate PK/H function for each vulnerable 
component encountered along the shotline. This results in a sequence of PK values {PK1, PK2, 
..., PKn} for the vulnerable components along the shotline in question. The total probability 
of killing one or more components is then computed according to the so called survival 
rule: 

Figure 36 - Shotline Pk example. 
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It is these total PK values that are color-coded as markers for each shotline. 
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6.0 Parallel Shotlines - Add Armor Option 

This option is accessed via the menu item Actions...Parallel Shotlines - Add Armor 
(Figure 37). This pops up the dialog shown in Figure 38 

This is the same dialog as for the  other parallel shotline options, but in this case TurboPK 
will do two calculations. First, it will determine the projectile (or fragment) impact mass 
and speed at the first vulnerable component encountered along each shotline. Second, for 
those shotlines where the impact speed and mass are greater than zero it will determine 
how much additional RHA (rolled homogeneous armor) is required to stop the projectile 
(or fragment). It does not add the RHA to the geometry of the target model, it just adds it to 

Figure 37 - Add Armor option. 



 
 

Page | 38 
 

the list of material segments along the shotline in question. Figure 39 shows the result of 
doing this for the dialog parameters shown in Figure 38. 

 

Figure 38 - Add Armor dialog. 
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Figure 39 - Add Armor example calculation. 

In Figure 38 note the scale is now 0.0 to 2.0 (inches of RHA). So the parameter Max RHA 
Addition. inches is the maximum that TurboPK will apply for the calculation in question.  
Note also the text in the status bar at the bottom of the main window. This text states that 
the weight of RHA added was roughly 448 pounds, and that 100% of the shotlines were 
protected. So no shotline required more than 2.0-inches of RHA to stop the projectile. 

The effect of reducing the maximum RHA addition to 0.75-inches along a shotline is shown 
in Figure 40. A black shotline marker means more than 0.75-inches RHA are required along 
that shotline.  Restricting the add-on RHA to no more than 0.75 inches reduces the total 
additional RHA weight to 103-lbs, but only 54.5% of the shotlines are now protected. 
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Figure 40 - Reducing the RHA add-on maximum to 0.75-in. 
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7.0 Single Burst Point Option 

This option in invoked from the menu item Actions...Single Burst Point.  In response the 
dialog box shown in Figure 41 pops up with the usual set of parameters. In Figure 41 the 
viewpoint has been changed to be almost side on. Figure 42 shows the fragment rays 
emanating from the example burst point. A white arrow was added to indicate the weapon 
approach angle.  

 

Figure 41 - Single Burst Point dialog. 
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The text in the bottom status bar indicates the total target PK in this example was 1.0. As in 
the other options that compute total target PK, a target "fault tree" file must be loaded, and 
component PK/H functions must be loaded for this computation to work. 

If the ray drawing option is changed to Rays that hit the target, and if the menu item 
View...View Vulnerable Only is activated then the image in Figure 43 results. Only rays 
that have one or more vulnerable components are drawn, and the component individual PK 
values (integrated over all impacts) are now used to color code the component's geometry. 
Only the result of the last Monte Carlo sample will be displayed. 

Figure 42 - Fragment rays. 
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Figure 43 - Displaying component PK values. 



 
 

Page | 44 
 

8.0 Graphics Display Control 

Figure 44 is an image of the graphics toolbar. Most of these capabilities are self 
explanatory; experiment with them, you'll figure them out.  

The selection tool (the arrow icon) works by hovering the cursor over a geometry object 
and then depressing the left mouse button. The selected object turns red and its ID is noted 
in the status bar at the bottom of the main window. Clicking on the object a second time de-
selects it. The menu item View...Deselect \ Unhide All will de-select everything that is in 
the “selected" state. 

In addition the mouse controls rotation of the screen image. Depressing the left mouse 
button and rolling the cursor rotates the image around the x axis.  Depressing the right 
mouse button and rolling the cursor rotates the image around the z axis.  The mouse wheel 
controls zooming. Once again, experimentation will show how they work. 

T r a n s l a t e

R e s e r v e d

S e l e c t

T r a n s p a r e n c y

Z o o m

S o l i d

W i r e  F r a m e

T r a n s l a t e

R e s e r v e d

S e l e c t

T r a n s p a r e n c y

Z o o m

S o l i d

W i r e  F r a m e

Figure 44 - Graphics toolbar. 
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9.0 Edit Menu 

Currently, the Edit...Point Size option is the only one that is operative. It allows you to 
increase / decrease the drawing size of points (in pixels) after points have been drawn. The 
Edit...Warhead Description option will be completed in a future release. 
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9.0 Warhead Files 

TurboPK supports two different warhead file formats. The first is the JTCG standard ZDATA 
format, and the second is a TurboPK-specific format called the "Polar Zone Warhead" 
format. ZDATA files have the file extension .zdata, while Polar Zone Warhead files have the 
file extension .pzw. 

ZDATA files are a standard format for fragmentation warhead descriptions. Figure 45 
shows the simple example provided with TurboPK displayed in Notepad. The top line in a 
ZDATA file is a title line and is read in but ignored by TurboPK. The second line must 

contain the string "ZDATA" followed by the number of polar zones in the warhead. In this 
case there is only one zone. Line 3 contains the polar zone limits (lower, mid, upper), the 
fragment speeds at the polar zone limits, and the number of fragment mass classes (4 in 
this case).  Line four contains the fragment masses, in grains for the four mass classes. Line 
5 specifies how many of each fragment mass class are in the polar zone. Line 6 is the drag 
coefficient to be used for all fragments in the file. A "real" ZDATA file would have many 
polar zones but Figure 45 gives you the general idea.  ZDATA files contain no information 
about fragment shape or material type, so TurboPK prompts the user with a dialog box to 
provide that information when a standard ZDATA file is loaded (Figure 6). Shape factors 
and shape factor parameters are described in Table 1. 

Table 1 

Shape Factor  Type Description 

1 Cube  

2 Sphere  

3 Uncontrolled Compact Modeled as a cylinder with L/D = 1.0 

4 Parallelepiped Square cross section. User specifies 
the edge dimension of the cross-
section. 

5 Uncontrolled Non-Compact Modeled as a cylinder with user-
specified L/D. 
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For use with TurboPK it is also possible to add material type and shape information as an 
extra line to a standard ZDATA file (Figure 46). The extra line stipulates the COVART 
material type for the fragment material (must be 1-6), the shape factor (0-5), and a shape 
factor parameter for shape factors 4 and 5. The shape factor parameter can be omitted for 
shapes 1-3. In the case of Figure 33 extra line stipulates material type 4, shape factor 5, and 
shape factor parameter 3.25. 

 

ZDATA files are limited to one material type and shape for all polar zones and mass classes. 
The Polar Zone Warhead (PZW) format allows each polar zone and mass class to have its 
own material code and shape factor. So, for example, the PZW format allows one to mix 
cubes and spheres in the same file. Figure 47 is an example PZW file. Figure 48 adds 
commentary at the end of each line (starting with the # symbol).  

Figure 46 - Augmented ZDATA file. 

Figure 45 - Example ZDATA file. 
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The example PZW has only one polar zone, but PZW files can have an unlimited number of 
zones (limited only by available memory). Each zone is separated in the file by a blank line. 
Polar zones are completely independent of each other in the file, i.e., they do not have to be 
in any particular order regarding angle boundaries. Multiple polar zones can have the same 
angle boundaries, for example, when modeling a polar zone with multiple fragment types. 

Figure 48 - Annotated PZW example file. 

Figure 47 - Example PZW file. 
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10.0 Shotline Inspector 

This option is for analyzing in detail a single shotline specified by the user.  Use the menu 
item Actions...Single Ray to launch the dialog box shown in Figure 49. 

 

The controls grouped on the left side of the dialog control the specification of the shotline. 
The controls on the right specify a fragment to trace along the shotline. 

In this context a shotline is defined as an "aim point" and a direction vector. The aim point 
is some point through which the shotline is forced to pass, for example a point on the 
surface of some vulnerable component of interest. There are two ways to define the aim 
point. The first is to simply type the desired coordinates into the edit controls labeled "x0," 
"y0," and "z0," respectively. The second is to click on the Pick Location button and use the 
mouse to select the point of interest. Clicking on the Pick Location button changes the 
mouse cursor to a crosshairs shape to indicate that the next mouse click will designate 

Figure 49 - Single ray dialog box. 
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where the aim point is to be located (Figure 50). A red oval has been added to Figure 38 to 
highlight the location of the crosshair cursor.  Clicking the left mouse button while the 
crosshair is hovered over the target image causes a ray to be fired "into the screen" as it 
were, and the first intersection with the target becomes the aim point. This point is 
displayed as a green point (Figure 51). 

 

  
Figure 50 - Selecting An Aim Point. 
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By default the target will be drawn with both azimuth and elevation angles set to 0.0 when 
the Actions...Single Ray menu item is selected. Azimuth and elevation refer to the 
direction of the shotline in target coordinates. Az = 0 and El = 0 is "head-on" so the 
direction vector is (-1,0,0). After picking the aim point shown in Figure 51the contents of 
the dialog box are updated to reflect the chosen aim point and direction (Figure 52). 

Figure 51 - Aim point marker. 
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Often the component of interest is an internal component, i.e., not visible to the user. To 
make it visible, first activate the menu item View...Hide Selected Objects options then 
select things to be hidden. Next activate selection mode by clicking on the arrow icon on 
the toolbar and selecting one or more items. Each time you "select" something it will not be 
drawn, thus exposing whatever is behind it. (The objects that are not drawn are however 
still part of the geometry model so they will be used in penetration analysis.) To expose the 
fragment vulnerable objects use the menu item View...Fragment Vulnerable. The effect of 
this is shown in Figure 53. 

Figure 52 - Aim point coordinates and direction. 
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The aim point picking operation only considers objects that are visible thus enabling the 
user to place the aim point on the surface of internal components. 

If the geometry model is rotated around via the mouse operations for rotation, and the user 
then selects an aim point via the Pick Location button, the direction vector and direction 
angles (azimuth and elevation) will be determined automatically and updated in the edit 
controls for those variables (Figure 54and Figure 55). 

 

Figure 53 - Fragment-vulnerable components only. 



 
 

Page | 54 
 

 

It is also possible to force a specific Az, El pair by typing the desired values into the Az and 
El edit controls then clicking on the Apply (Az, El) button. If you do that the target will be 
redrawn at the desired angles and the direction vector controls will be changed to be for 
the new Az, El values. The direction vector is changed whenever the shotline approach 
angles are changed. The edit controls dir x, etc are read only.  

Figure 54 -  User rotation defines Az, El, and direction 
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To preview the shotline click on the Preview Shotline button and a yellow line should 
appear showing the shotline path through the target (Figure 56). Given an aim point and a 
direction vector the code will start the shotline outside the target bounds. Because the 
viewing angle corresponds to looking down the shotline the shotline is not visible until the 
screen view is rotated away from the shotline angles. That has been done in Figure 56. 

Figure 55 - Az, El, and direction vector updated. 
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Clicking the Apply button causes the code to fire the fragment specified down the shotline 
specified. At each intersection with a target object the code will record the impact speed, 
impact mass, exit speed, exit mass, and obliquity. If the component is a vulnerable 
component it records the PK/H for that impact, and also updates a total shotline PK. The 
latter does not invoke the fault tree; it computes a simple PK by applying the survival rule 
to all PK/H values encountered to that point. A text window pops up to report the results 
(Figure 57). The value "Segment Length" is the actual line-of-sight segment length. The 
value "Modified Length" applies the COVART thickness factor to that if the component is a 
volume-mode component. Figure 57 is for a 260-grain fragment. 

Figure 56 -  Shotline Preview 
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Figure 57 - Shotline history. 
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11.0 Burst Point Grid Polar Coordinates 

Some users prefer to idealize the warhead as being at the origin and the target being 
displaced w.r.t. the origin. TurboPK now implements this as an option. It is invoked via the 
menu item Actions...Burst Point Grid - Polar Coordinates. Selecting this menu item pops 
up the dialog box shown in Figure 58. "Weapon Parameters" include projectile orientation 
and CG location. Currently, only two projectile orientations are offered, (1) nose down, and 
(2) horizontal. Targets are placed along radial lines emanating from the origin. "Burst Point 
Grid Parameters" include the angular spacing of the radials, the distance (radius) spacing 
along each radial, a maximum radius, and the number of Monte Carlo point-bursts to be 
done at each burst point. 

 

Figure 59 shows an example polar coordinate grid calculation. The target in this case was 
the lightly armored vehicle discussed in previous examples. 

Figure 58 - Polar coordinate option dialog. 
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The current release fixes the weapon elevation angle to either 90-degrees ("Nose Down") 
or 0-degrees ("Horizontal"). Note that the azimuth angle of approach is not directly 
specified, so it is by default 0-degrees. A future version of the code will allow the user to 
specify a particular azimuth angle, or a range of azimuth angles over which the PK results 
will be averaged. 

  

Figure 59 -  Example polar coordinate grid calculation. 
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12.0 Rectangle of Trajectories Option 

This option is invoked from the menu item Actions...Rectangle of Trajectories (Figure 
60). The associated dialog box is shown in Figure 61. The idea is to generate a set of 
trajectories, in weapon coordinates, inside a rectangle defined by "dragging a rectangle" via 
the mouse. (A good example of "Dragging a rectangle" is the selection tool in the Microsoft 
Paint program.) The general idea for this option is to allow the user to specify a collection 
of trajectories on or near the target geometry and to examine PK as a function of position 
along these trajectories. 

 

Figure 60 - Invoking the "Rectangle of Trajectories" option. 
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Defining the rectangle starts by clicking on the Define Trajectory Rectangle button, which 
puts the mouse into "drag rectangle" mode.  A rectangle is then defined by positioning the 
cursor in the main window, depressing the left mouse button, and rolling the mouse while 
keeping the left mouse button depressed. Figure 62 shows an example of this. 

Figure 61 - Rectangle of Trajectories dialog. 
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In this option the user is in the weapon coordinate system looking at the target. The 
weapon's path is "into the screen" as it were. The rotational orientation of the target can be 
set by normal rotation operations via the mouse, or the user can set explicit values for 
azimuth and elevation angles via the menu item View...Set Specific Az/El. Given a 
rectangle defining the boundaries for a set of trajectories the user specifies several 
parameters that control the trajectory generation (Figure 60). "Trajectory Spacing" is the 
spacing of the trajectories within the rectangle. For each trajectory the code will generate a 
set of burst points along the trajectory spaced at the interval "Burst Point Spacing."  The 
parameters "Extend Front" and "Extend Back" allow the user to lengthen the trajectories.  

When the user clicks on the "Generate Trajectories" button a set of lines representing the 
trajectories is drawn. Rotate the viewing angle to make these lines visible. Figure 63 shows 
the trajectories generated in the rectangle shown in Figure 62. Note that the trajectories 
start before they reach the target and end after they pass the target. The cushion is roughly 
the diagonal distance of the target bounding box. The cushion in front can be increased via 
the "Extend Front" parameter. The cushion in back can be increased via the "Extend Back" 
parameter. 

Figure 62 - A rectangle defined on the screen. 
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Figure 63 - Rotated view makes trajectories visible. 

The other parameters in the dialog box define the number of point-burst samples to be 
done at each burst location, the weapon's speed, and so forth. These have all been 
described previously. 

Clicking on the button labeled "Analyze Trajectories" causes the burst points to be 
generated and analyzed. Color coded PK markers are displayed when the calculations have 
completed. Figure 64 and Figure 65 show the results for the example rectangle. 
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Figure 64 – PK markers oblique view. 
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Figure 65 – PK markers side view. 

By default trajectories will pass right through any target geometry they encounter. For 
example the trajectory rectangle shown in Figure 66 generates the trajectories shown in 
Figure 67. Figure 67 is restricted to showing just the vulnerable components. 
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Figure 66 - Trajectories that pass through the target 
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Figure 67 - Trajectories that pass through the target geometry. 

Figure 68 shows the PK results for the example trajectories, and clearly shows burst points 
internal to the target model. 
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Figure 68 – PK markers for the example trajectories. 

There is an option for emulating a contact fuze. To use it check the box labeled "Emulate 
Contact Fuze" and specify a delay distance. Under this option trajectories that intersect the 
target geometry will terminate at the contact point plus the delay distance. Trajectories 
that do not intersect the target geometry are not affected. Figure 69 and-Figure 70 show an 
example of emulating a contact fuze with a delay distance of 0.0 
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Figure 69 - Trajectories for contact fuze example. 

Figure 70 shows the PK results. In this case the burst points stop where the trajectories first 
intersect the target. As with the other contact fuze options in TurboPK a positive delay 
distance moves the burst points past the first point of contact. A negative delay distance 
moves the burst point back up the trajectory simulating a standoff fuze. 
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Figure 70 - Contact fuze example. 
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13.0 Air Blast Model 

TurboPK implements the Sadovsky equation for predicting air blast overpressure as a 
function of explosive mass (TNT equivalent mass) and distance from the charge.  

 

Where: 

m    = "TNT Equivalent" explosive mass, in Kg. 

r      = Standoff distance, in meters. 

1
p  = overpressure, in atmospheres. 

The explosive mass is the "energy equivalent" mass of TNT. For example, PBXN-9 has a TNT 
equivalency factor of 1.6. So 1 Kg of PBXN-9 is equivalent to 1.6 Kg of TNT. Figure 71 shows 
the Sadovsky equation overpressure for 213 grams of TNT. Pressure is converted to psi in 
Figure 71. One atmosphere = 14.7 psi. As can be seen in Figure 71, overpressure falls off 
very rapidly as standoff distances increases. 

 

Overpressure Versus Distance  -  220 grams PBXN-9
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Overpressure versus Distance - 213 grams  TNT 
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The "TNT Equivalent Weight" parameter is loaded immediately after a warhead file is 
loaded. The user is prompted by the dialog shown in Figure 72. 

 

Typically, component damage to air blast is expressed as a critical peak overpressure 
delivered to the surface of the component. Peak pressure above the critical value results in 
PK of 1.0 for the component, and PK of 0.0 otherwise. This is the model implemented in 
TurboPK. The user identifies a list of blast-vulnerable components and a critical 
overpressure for each. Currently this is implemented as an ASCII file that is loaded at run 
time. Figure 73 shows an example for a handful of components. A complete file would likely 
be dozens of components. 

 

In this simplified example there are only five blast-vulnerable components. The file format 
is one component per line containing the object's COVART code number and the critical 
overpressure required to kill that component. The components do not have to appear in 
any particular order. A blast-vulnerability file is loaded via the menu item File...Open Air 
Blast File (Figure 74). 

Figure 73 - Example blast vulnerability file. 

Figure 72 - TNT equivalent weight dialog. 
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The View menu has been modified to allow the user to display (1) all geometry, (2) all 
vulnerable geometry, (3) blast-vulnerable geometry, and (4) fragment-vulnerable 
geometry. Figure 75 shows the blast-vulnerable geometry defined by the example vehicle 
model. Figure 76 shows the fragment-vulnerable geometry for the same target.   Of course, 
more than the handful of panels shown in Figure 75 are typically blast-vulnerable, and in 
many cases components are vulnerable to both blast and fragments. 

Figure 74 - Loading an air blast vulnerability file. 
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Figure 75 - Blast vulnerable geometry 
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Figure 76 - Fragment vulnerable geometry. 

In addition to loading a blast-vulnerability file the user must add the blast-vulnerable 
components to the fault tree for blast damage to be recognized. If the components in 
question are already in the fault tree (because they are also fragment-vulnerable) then they 
do not have to be added again. Only uniquely blast-vulnerable components have to be 
added. Figure 77 shows a fault tree with a group added to the bottom for blast-vulnerable 
components (the same ones listed in Figure 73). 
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The Edit menu now has a "Write a default air blast file,” which is a helper function for 
creating an air blast file. When this menu item is invoked it asks the user to specify an 
output file name then pops up the dialog box shown in Figure 79.   

Figure 77 - Blast-vulnerable components in a fault tree. 
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Figure 78 - The Edit menu. 
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Figure 79 - Default air blast parameters. 

This dialog allows the user to define a default critical overpressure for blast vulnerable 
components, and also allows the user to restrict the components written out to be those 
that are already vulnerable to fragments. (Note: Most structural elements are typically not 
considered vulnerable to fragments so leave this box unchecked if you want the structural 
elements written out to the file too.)  
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14.0 Miscellaneous 

The Edit menu shown in Figure 78 has an item labeled "Point Size" which pops up a dialog 
box for defining the size, in pixels, of points that are drawn on the screen (for example, PK 
markers). The menu item labeled "Reset the Random Number Generator" does exactly that. 
The menu item labeled "Check the Fault Tree" will scan the fault tree for items that are not 
flagged as vulnerable to either fragments or air blast. While technically not an error, 
including non-vulnerable components is probably not what the user intended. If any are 
found a text dialog will pop up listing the names of the suspect items in the fault tree. 

The View menu now contains an item labeled "Set Specific Az / El" which pops up a dialog 
box for specifying the Az / El pair (Figure 80). In this case the Az / El being specified are the 
viewing angles, not weapon approach angles.  

 

The View menu also has an item labeled "View List of Files Loaded" which will show the 
user which files have been loaded for the current computing session. For example, Figure 
81 shows the list of files loaded from the example Vehicle folder. 

Figure 80 - Setting specific viewing angles. 
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Figure 81 - Listing files that are currently in use. 


